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Your Expectations?

Basics of Simulink & MathWorks:



Introduction to Simulink, Stateflow and
Code Generation

References to the book MATLAB — Simulink — Stateflow
(Angermann, Beuschel, Rau, Wohlfarth, Oldenburg Verlag)
- Supported by MathWorks -
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Simulink

Key Features

« Graphical editor for building and managing
hierarchical block diagrams

» Libraries of predefined blocks for modeling
continuous-time and discrete-time systems

« Simulation engine with fixed-step and variable-step ODE solvers for discrete and
continuous time modelling

« Scopes and data displays for viewing simulation results

* Project and data management tools for managing model files and data

* Model analysis tools for refining model architecture and increasing simulation speed

«  MATLAB Function block for importing MATLAB algorithms into models

 Legacy Code Tool for importing C and C++ code into models

« Automatic code generation capabilities for C, C++, Structured Text and HDL

«  Multi domain modelling using signal flow diagrams, state machines and physical modelling
« Capabilities to directly interact with hardware and real time systems
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Application Examples

* Plant modelling

— Modelling of nonlinear dynamic systems
(continuous-time, discrete-time, hybrid)

— Analyses of dynamic systems (pre-development)
— Optimization of dynamic systems (system design)

%
v A

The HB-SIA aircraft on a test flight over San
Francisco Bay. Photo © Solar Impulse | Revillard |

» Design of embedded systems
— Model-based software development

— Automatic code generation (software and
programmable hardware)

The Festo Bionic Handling Assistant. Image © Festo
AG

* Model-based testing

— Open- and closed-loop testing of plant model and
control software

— Formal methods for software verification A Bosch eBike Systems drive it
— Hardware in the loop testing

www.mathworks.com/company/user_stories/
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Launching Simulink

HOME PLOTS  APPS SHORTCUTS 0 5L Code Inspector Lib 27 Buseditor (AL [ | o R o o (2] 5earch Documentatian

E}L E::::' ?j [E =T & E [z, New Variable

t open variable +

New MNew Open IE‘_ICDmpare Import Save

Script « - Data Workspace [ Clear Workspace ~
FILE VARIABLE

| &7 Analyze Code ] =} {6} Preferences 2

IC1S)]

%7 Run and Time (5l Set Path

Simulink  Lapout Help

|72 Clear Commands Library ~  =dParaliel = -

CODE MULIN ENVIRONMENT

E Regquest Support

A= 5= L ¢ Users » MHORNL » Documents » MATLABE » Exercises TUM_GS_Training * A

Warkspace | Current Folder ® | Com

Mame Date Modified »>> simulink

£ File Folder 55
dagwaterfall 16.11.201219:15
MATLAB_Ex 16.11.201219:15
MuPA&D 16.11.201219:15
Simulink 14.01.201312:45
SL_Figure_Demo 1611.201219:15
Stateflow 16.11.201219:15

HEEEBHEBE

Details

Command History

~plot(t,¥)
—clear all
—cloge all
ele
~example foo
—clear all
—cloge all
—cle
—graf3id

Starting Simulink
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Simulink Library Browser

Frequenthy Used

File Edit View Help
& 3 » | Enter search term ~ 4 G,
Libraries Library: Simulink | Search Results: (none}
> Simulink oo —
. mmanly
Aeruspacg Blu?ckset E nﬁ —
; Communications System Toolbox
> Computer Vision System Toolbox ] o
Control System Toolbox Diserate I3
> D5P Systemn Toolbox
4 Embedded Coder + - Math )
> HDL Verifier % Cperations Q
Irmage Acquisition Toolbox o
Instrument Control Toolbox :%é» Ezz :lt:—ms E
Model Predictive Control Toolbox g
Real-Time Windows Target BH =
Report Generator ey fns= P
Robust Control Toolbox
> SimEvents = Additional Math

oY [e¥ [o¥ =¥ [o¥ ¥ [o¥ [e¥ [o¥ [e¥ [o¥ [a¥ [o¥ ¥ [o¥ [o¥ [o¥ o [a¥ [=¥ [o¥ [ [o¥ [ [o¥ =¥ [a¥ [=F

SimRF

Simscape

Simulink 3D Animation
Simulink Coder

Simulink Control Design
Simulink Design Optimization
Simulink Design Verifier
Simulink Extras

Simulink Verification and Validation
Stateflow

Systern Identification Toolbox
Yehicle Metwork Toolbox

*PC Target

& Disorete

Continuous

Logic and Bit
Operations

Maodel
Verification

Signal Attributes

Sources

IRGIRE

Discontinuities

Lockup Tables

Model-Wide
Utilities

Signal Routing

User-Defined
Functions

Showing: Simulink
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Finding B

locks

File

2o e Oma

Edit  Wiew

Help

Libraries

Library: SimulinkiLookup Tables

Found: "cos’

Frequently Used

4 [%] Simulink

»

o [o¥ [ [o¥ [ [o¥ [ [o¥ [ [o¥ Jo¥ [o¥ =¥ [o¥ ¥ [o¥ ]

Commonly Used Blocks
Continuous

Discontinuities

Discrete

Legic and Bit Operations
Lookup Tables

Math Operations

Medel Verification
Model-Wide Utilities

Ports & Subsystems

Signal Attributes

Signal Routing

Sinks

Sources

User-Defined Functions
Additional Math & Discrete
Aerospace Blockset
Communications System Toolbox
Computer Vision System Toolbox
Control System Toolbox
DSP System Toolbox
Embedded Coder

HDL Verifier

Image Acquisition Toolbox
Instrument Control Toolbox
Model Predictive Control Toolbox
Real-Time Windows Target
Report Generator

Robust Control Toolbox
SimEvents

SimRF

Simscape

m

-

Simulink

Rty

Cosine

| Aerospace Blockset

10 )|

aa BN

Direction Cosine
Matrix to Cua...

Direction Cosine
Matrix ECEF 1...

Direction Cosine
Matrix to Wind...

Wind Angles to
Direction Cosi...

Direction Cosine
Matrix Body to...

Direction Cosine
Matrix ECEF t...

Cuaternions to
Direction Cosi...

Direction Cosine
Matrix Bedy to...

Direction Cosine
Matrix to Rota...

Rotation Angles
to Direction C...

| Communications System Toolbox

23|

Raised Cosineg
)

Receive Filter

N

Raised Cosine
Transmit Filter

Cosimulation

HDL
Cosimulaticn

Scquare oot Saquare ro0d
| HOL verifier 23|
- HDL |

Matches for ‘cos” 4 blocksets 0 subsystems

15 blocks
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11
Getting Help

s L Es
Tools

L oA | Using Simulink
— .
Blocks
Blocksets 3
Block Support Table 3 - 2
Shortcuts E Function Block Parameters: Gain A
T S-Functions — Gain
Demos Element-wise gain (y = K.*u} or matrix gain (y = K*u or y = u™K).
N
Terms of Use... Main | Signal Attributes I Parameter Attributes |
Patents... Gain:
About Simulink ]_Jn’]_[]|
+ [ Il
Multiplication: [EIement—wise(K.*u} hd

Sample time (-1 for inherited):

-1
Type 1
Select the type of solver you want to use to simulate your
J- [ oK i ’ Cancel ] ’ Help Apply model.
- settings
Default: Variable-step B
Configuration P ters: i fipuration (Acti Variable-step
e . guration (Active) Step size varies from step to step, depending on
Select: Simulation time | model dynamics. A variable-step solver:
- Solver Start hines |D.D | Stop time: | 10.0 * Reduces step size when model states change
- Data Import/Export rapidly, to maintain accuracy.
- Optimization I | .
) . Solver options deecas sonsas = * Increases step size when model states change
[=-Diagnostics ) I
i-Sample Time what's This? | = slowly, to avoid unnecessary steps.
EE |\-'ariahleshep Y| Solvertl e PTINCE) | Variable-step is recommended for models in which
discrete (no continuous states i in di inuiti
Max step size: |aub3 | FEgiie T e ( ) states change rap|_d|3.r or that contain dls_.conhnume_s. In
h ; these cases. a variable-step solver requires fewer time
Min step size: | auto | Absolute tolerance: Djeﬁg(sigdad"'s"'amp'”e) steps than a fixed-step solver to achieve a comparable
odel Referending Ed:ws [(sﬁf‘;fn;,ng) level of accuracy. This can significantly shorten
Initial step size: |auto Shay eservation: i ion ti
-Saving P | | 23 ode23s (stiff/Mod. Rosenbrock) simulation time. -
- Hardware Implementation Number of consecutive min steps: ode23t (mo_d. stiffTrapezoidal) |
. Model Referencing ode23th (stiff/TR-BOFZ) | H‘
[-Simulation Target Tasking and sample time options =

Basics of Simulink ‘ MathWorks:



Demonstration of Model Elements

File Edit View Display Diagram Simulation Analysis Code Tools Help

E-8 5 BE-8 40P (&) ~ inf Normal X @~ -

SL_Intruduction_Demo |

@
G‘l 03
[ » ]
— o4 » l—l
= Displey
L—» |+ =P
[
Constan Slider
Fain
> (=[]
"n\{j &E >+ mod > ‘}=1 >
Sine Wave Gain o
3 =]
Add - — Scope
Math
Function
o7
Switch
»
Ready 100% oded5
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Summary — Using Blocks and Signals

Adding Blocks:

Drag and drop a block from the Simulink library into the
block diagram

Copy a block inside the block diagram by dragging it
while holding the right mouse key

Click into the block diagram and start to enter the name
of the block (R14b)

Connecting Blocks:

Draw a line from the outport of one block to the inport of
a second block using the left mouse key

To connect a block to a line, draw a line from the inport of
the block backwards to the line to connect to.

To quick connect two blocks, click on the outport of the
first block and the inport of the second block while
keeping the CRTL-key pressed

Click the suggested connection lines (R14b)

%)—<>—>| >

Gain1

——(D

Out1

> @>

Gain1
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Simulation Data Inspector

14

ram Simulatio alysis Code Tools Help
@ g @ > e 4 0 » @ w -
Simulation Data Inspector
Stream Selected Signals to Data Inspector
Log Selected Signals to Workspace
Send Logged Workspace Data to Data Inspector
®» Configure Logging and Streaming...
T == | @ Help on Simulation Data Inspector... untitled* - Simulation Data Inspector -
[ VISUALIZE COMPARE FORMAT
c‘é::‘ & import ] Clear Pt = gz::l:'“ Qe a Slcreaterepot  (2)
Hioe ~ P Export | g Delete ~ . QEIR oaecursors Honignt Fllsenstofue  hep |
- FILE | EDIT ~ RUNS |ZoOM & PAN|  MEASURE & TRACE SHARE |ResourcE
: coor 4
~ Run 2: Input_Mass_Spring_Damper 09 /\\‘ /\ /\ /\ ’//\ /\‘
2 » = ANAWA / | ; [ ;
CENNEEN .| / - | J IREE (r
I f
VoL ‘, \[ 1] [
| [ \ f | |
= J (1 1 | l
{ ( !
| | J I { [
. \ 1 / L
1 ‘ 1 J
P I W - 1 ‘ \ fl
AL 1 f
i / | ‘J | [
08 \ { \ | | (g
} | ‘ \ f f \ |
- ‘ | \ \
Name v \ | | / { \ r' \ |
Line Appearance — =2 1\/ \/ \\/1 i\/ \/ \//
Color — !
Units a2
Model Input_Mass_Spring
Block Name y1
Block Path Input_Mass_Spring e
Port 0
o 50 100 150 200 250 300 350 400 450

500
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Outline
Simulink and Stateflow
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« Basics
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* Discrete Models
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3) Model Advisor
4) Report Generator and Model Comparison
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Modeling Continuous Systems

* Engine provides variable-step and fixed-step ODE solvers
» Block Diagram representation of dynamic systems

« Blocks define governing equations

« Signals are propagated between blocks over time

« Remeber MuPad: mx + bx + kx =0,
x(0)=0,x(0)=1,m=10,b =1,k =10

uScope } SHECE X

« Exercise: Create a mass-spring-damper system |#E®»» AGE & a5
in Simulink

TI.ITI Basics of Simulink 4\ MathWorks:



Algebraic Loops

« Error because of Direct Feedthrough
— Block input depends directly on its own output
— E.g.: Gain, Product, Sum/Subtract, Transfer Fcn

 Recommended solution: use Delay, Integrator or Sustact
other history related block

Block diagram 'untitled’ contains an algebraic loop, The algebraic loop solver is disabled because of the current
setting for Algebraic loop option in the Diagnostics page of the Configuration Parameters Dialog

« Alternative, but bad solution:
reduce diagnostics settings and o T R e TR TS — —

leave solving up to Simulink - ( — |

[+~ Optimization [ L ‘]

engine (not recommended!!) — )

~Sample Time
~Data Validity Min step size violation: [warning 'l
~Type Conversion . o
- Connactivity Sample hit time adjusting: [none 'I
Compatibility Consecutive zero crossings violation: [error - I
Model Referencing
Saving Unspecified inheritability of sample time: [warning 'I
- Stateflows Solver data inconsistancy: [none ']
~Hardware Implementat... -
~Model Referencing Automatic solver parameter selection: [warning V]
- Simulation Target Extraneous discrete derivative signals: [error VI
[ Code Generation
[#-HDOL Code Generation State name clash: [warning VI
SimState interface checksum mismatch: [warnmg VI
SimState object from earlier release: [error 'I
7 ] [ 0K } [ Cancel ] [ Help ] Apply
=
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Solver

« Solver?

File Edit View Display Diagram

-8 =

Simulation  Analysis Code Tools Help
1]} = % \
EelE ¢Op = ©-w

@ Medel Configuration Parameters Ctrl+E

@ Simulation Target For MATLAB & Stateflow
[E Model Properties
1 — T - =T
@ ! > = [
o Integrator 1 Scope
=
e O
select: Simulation time
Solver Start time: 0.0
Data Impart/Export
> QOptimization

Solver options
* Diagnostics

Stop time: 100

Hardware Implementation Type: Variable-step

~ | Solver:

[ode-ls (Dormand-Prince) ']

Model Referencing
> simulation Target
> Code Generation
> HDL Code Generation

Max step size:  auto
Min step size:  auto

Tnitial step size: auto
Number of consecutive min steps:

Tasking and sample time options

discrete (no continuous states’

Relative tolerance:

Absolute tolerance: |0de23 (Bogacki-Shampine)
odel113 (Adams)

Shape preservation: | ode15s (stiff/NDF) B
ode23s (stiff/Mod. Rosenbrock)
auto ode23t (mod. stiff/Trapezoidal)

ode23th (stiff/ TR-BDF2)

m

— Determines solution at current time step

Determines the next simulation time step

Tasking mode for periodic sample times: Auto
[7] Automatically handle rate transition for data transfer

["] Higher priority value indicates higher task priority

« Solver options:

Fixed-Step
v'Odel
v'Ode2
v'Ode3
v'Ode4
v'Ode5
v'Ode8

Variable-Step
v'Ode45
v'0Ode23
v'Odell3
v'Odelb5s
v'Ode23s
v'Ode23t
v'Ode23tb

Basics of Simulink
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Fixed-step Solver

Fixed-step Solvers.

Default: ode3 (Bogacki-Shampine)

ode3 (Bogacki-Shampine)
Computes the model's state at the next time step as an explicit function of the current value of the state and the state denvatives, using the Bogacki-Shampine Formula
integration technigue to compute the state derivatives. In the following example, X is the state, DX is the state denvative, and ko is the step size:

¥(n+l) = ¥X(n) + h * DX(n)

Discrete (no continuous states)
Computes the time of the next time step by adding a fixed step size to the current time.

Use this solver for models with no states or discrete states only, using a fixed step size. Relies on the model's blocks to update discrete states.

The accuracy and length of time of the resulting simulation depends on the size of the steps taken by the simulation: the smaller the step size. the more accurate the results
but the longer the simulation takes.

Note The fixed-step discrete solver cannot be used to simulate models that have continuous states.

odef (Dormand-Prince REEB (7))
Uses the eighth-order Dormand-Prince formula to compute the model state at the next time step as an explicit function of the current value of the state and the state
dervatives approximated at intermediate points.

odeS (Dormand-Prince)
Uses the fith-order Dormand-Prince formula to compute the model state at the next time step as an explicit function of the current value of the state and the state derivatives
approximated at intermediate points.

oded (Runge-Kutta)
Uses the fourth-order Runge-Kutta (RK4) formula to compute the model state at the next time step as an explicit function of the current value of the state and the state
derivatives.

ode2 (Heun)
Uses the Heun integration method to compute the model state at the next time step as an explicit function of the current value of the state and the state derivatives.

odel (Euler)
Uses the Euler integration method to compute the model state at the next time step as an explicit function of the current value of the state and the state dervatives.

odeldx (extrapolation)
Uses a combination of Newton's method and extrapolation from the current value to compute the model’s state at the next time step, as an implicit function of the state and
the state derivative at the next time step. In the following example, X is the state, DX is the state dervative, and h is the step size:

¥in+l) - ¥(n) - h * DX(n+l) = 0

This solver requires more computation per step than an explicit solver, but is more accurate for a given step size.

TI.ITI Basics of Simulink 4\ MathWorks:



Variable-step Solver

Variable step Solvers.

Default: ode45 (Dormand-Frince)

ode45 (Dormand-Prince)
Computes the model's state at the next time step using an explicit Runge-Kutta (4.5) formula (the Dormand-Prince pair) for numerical integration.

ode45 is a one-step solver, and therefore only needs the solution at the preceding time point.
Use ode45 as a first try for most problems.

Discrete (no continuous states)
Computes the time of the next step by adding a step size that varies depending on the rate of change of the model's states.

Use this solver for models with no states or discrete states only, using a variable step size.

ode23 (Bogacki-Shampine)
Computes the model's state at the next time step using an explicit Runge-Kutta (2.3) formula (the Bogacki-Shampine pair) for numerical integration.

ode23 is a one-step solver, and therefore only needs the solution at the preceding time point.
ode23 is more efficient than ode45 at crude tolerances and in the presence of mild stiffness.

odell3 (Rdams)
Computes the model's state at the next time step using a variable-order Adams-Bashforth-Moulton PECE numerical integration technique.

odell3 is a multistep solver, and thus generally needs the solutions at several preceding time points to compute the current solution.
odel113 can be more efficient than ode45 at stringent tolerances.

odelSs (stiff/NDF)
Computes the model's state at the next time step using variable-order numerical differentiation formulas (WDFs). These are related to, but more efficient than the backward
differentiation formulas (BDFs), also known as Gear's method.

odelSs is a multistep solver, and thus generally needs the solutions at several preceding time points to compute the current solution.
odel5s is efficient for stiff problems. Try this solver if ode45 fails or is inefficient.

ode23s (stiff/Mod. Rosenbrock)
Computes the model's state at the next time step using a modified Rosenbrock formula of order 2.

ode23s is a one-step solver, and therefore only needs the solution at the preceding time point.
ode23s is more efficient than ode15s at crude tolerances, and can solve stiff problems for which ode15s is ineffective.

ode23t (Mod. stiff/Trapezoidal)
Computes the model's state at the next time step using an implementation of the trapezoidal rule with a "free” interpolant.

odeZ3t is a one-step solver, and therefore only needs the solution at the preceding time point.
Use ode23t ifthe problem is only moderately stiff and you need a solution with no numerical damping.
ode23tb (stiff/TR-EDF2)
Computes the model's state at the next time step using a multistep implementation of TR-BOF2, an implicit Runge-Kutta formula with a trapezoidal rule first stage, and a

second stage consisting of a backward differentiation formula of order two. By construction, the same iteration matrix is used in evaluating both stages.

ode2 3tk is more efficient than odel15= at crude tolerances. and can solve stiff problems for which odel15s is ineffective.

Basics of Simulink 4\ MathWorks



Variable-step Size

[ — 1

start

max

stop
50

Max step size is the largest
time step that the solver can
take (‘auto’ means 50 steps)

@ Configuration Parameters: untitled/Configuration (Active) - B
Select: Simulation time
Solver Start time: 0.0 Stop time: 10.0
Data Import/Export .
Optimization Solver options
Diagnostics Type: Variable-step - Solver: ode45 (Dormand-Prince)
Hardware Implementati...
Model Referencing Max step size:  auto Relative tolerance:  1le-3
Simulation Target Min step size:  auto Absolute tolerance: auto
Code Generation
Initial step size: auto Shape preservation: Disable All
Number of consecutive min steps: 1
Tasking and sample time options
Tasking mode for periodic sample times: Auto
|| Automatically handle rate transition for data transfer
|| Higher priority value indicates higher task priority
Zero-crossing options
Zero-crossing control: Use local settings - Algorithm: Nonadaptive
Time tolerance: 10*128*eps Signal threshold: auto
Number of consecutive zero crossings: 1000
@ (0]4 Cancel Help Apply

TUTI

Basics of Simulink
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Demo: Importing and Exporting Data

File Edit View Display Diagram Simulation Analysis Code Tools Help

E'Eﬁ %E@' %'\E)HD (&) > 500 Mormal - @vlf]v

Input_Mass_Spring_Damper |

@
I
-
Scope?
o 4
Inpuust
.
>
.-1
¥ dot dot 9 ¥ dot MK x ¥
CO———() o 1 e >
u I o 2
x_dot_dat Gain
x
— it k'm
Gain1
Add
=
Ready 100% ode3
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Importing Data into Simulink

IN
* Requires vector of time along with input values
input( t, u,...u, ) defined configuration parameters
CONSTANT
« Changeable on the highest hierarchy level [ ‘
« Tunable with parameter objects 1
FROM WORKSPACE

* Requires vector of time along with input values
input( t, u,...u, ) defined a workspace variable I simin Iﬁ

From

FROM FILE
* Requires vector of time along with input values
input( t, u,...u, ) defined in a given mat file ottledmat |

From File

TI_ITI Basics of Simulink 4\ MathWorks:



Exporting Data to MATLAB Workspace

ouT

« Saves all outputs together in one variable, defined in the
configuration parameters out

TO WORKSPACE

« Saves the output data in a variable to the workspace, ot I
defined in the block parameters

TO FILE
« Saves the output data in a .mat file untitied. mat I

To File

TI_ITI Basics of Simulink 4\ MathWorks:



Exchanging Data with MATLAB Workspace

For IN and OUT blocks variables must be
defined in Configuration Parameters

Select:

Salver
Data Import/Expo
» Optimization
» Diagnostics
Hardware Implementatio
Model Referencing
> Simulation Target
* Code Generation
* HOL Code Generation

C

States: et
Output: yout >
G

Load frontxoskspece

Input: [t, Command]

Save to workspace

Time, State, Output

[ EdDmput |

Time: tout Format: Array
Limit data points to last: 1000
Decimation: 1

Save complete SimState in final state

I
YT

Signals

Signal logging:  logsout

Signal logging format: |ModelDatalLogs -

[ Configure Signals to Log...

Data Store Memory

Data stores:  dsmout

Save options

Output options: Refine output ~ | Refine factor: 1

[T] save simulation output as single object |out

[T Record and inspect simulation output

m

0K

” Cancel ][

Help H Apply

Basics of Simulink
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MATLAB Embedded

« Subset of MATLAB for code generation

« Can be used for direct generation of
source code out of MATLAB as well as in — ;imt y—
Simulink MATLAB Function blocks

« Enables user to reuse his MATLAB code

iIn Simulink
« To call unsupported functions use @

eml.extrinsic Or coder.extrinsic
(leads to significantly reduced
performance!!!) =

EDITOR VEW {23 5L Code Inspector Lib S Buseditor (2] (5] o
: [ - ™~ - bidi 2
ED:' i E i msert (=) fx < 5 Q:) - 4 GoToDiagram (3) Simulation Target @

MATLAB Function

~ Compare ¥ Comment % 1 GoTo v
New Open Save 2o B % vl Breakpoints  Run  Siop BuidModel o EdtData | View Report Help
- - > (= Print = Indent ) |sen ({ Find - Model  Model - -
EDIT MNAVIGATE BREAKFOINTS RUW | SIMULINK

funetion v = fen(u)
*#codegen

R
I

¥ = u:

fen Ln 4 Col 7
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Model and Block Callbacks

27

Can't Undo

Can't Redo

Paste

Paste Duplicate Inport
Select All

Rernove Highlighting
Highlight ...

Muost Frequently Used Blocks

Back
Forward

Go To Parent
Link Options

Find Referenced Variables...
Coverage

Requirements

Update Diagram

Configuration Parameters...
Muodel Properties
Fixed-Point Tool...

Signal & Scope Manager...
Screen Color

Library Link Display
Sample Time Display

Frirrmat

by

Increment

Meduls

tenth_|

Open Block
Open Block In New Window
Explore

Cut

Copy
Delete

Variant 4
Mask Parameters...

Subsystern Parameters...

Block Properties...

Model Advisor...

Convert to Model Block

Find Referenced Variables...

Coverage 3
Requirements »
Design Yerifier 4
Code Generation 3
HDL Code Generation 3

- Block Properties:tenth_seconds

General || Block Annotation || Callbacks ‘

Usage

*(has saved content).

Callback functions list:

ClipboardFcn -

CloseFcn b
ContinueFcn
CopyFecn
DeleteChildFcn
DeleteFcn
DestroyFcn
InitFcn

LoadFcn
ModelClozeFcn
MoveFcn
MameChangeFcn
OpenFen
ParentCloseFen
PauseFcn
PostSaveFcn
PreCopyFcn
IPreDeleteFocn 7|

m

To create or edit a callback function for this block, select it in the callback list
(below, left). Then enter MATLAB code that implements the function in the
content pane (below, right). The callback name's suffix indicates its status:

Content of callback function: "ClipbeardFcn™

[ ok | [ cancel | [ Help | | appy

1

Basics of Simulink
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Callback Functions

Common tasks you can achieve by using callback functions include:

Loading variables into the MATLAB workspace automatically when you

open your Simulink model

Executing a MATLAB script by double-clicking on a block
Executing a series of commands before starting a simulation
Executing commands when a block diagram is closed

Load

v

Initialize

A 4

Start

v

Continue

!

D

Stop

v

Close

Cal Model Properties: untitled | x|

_ Main Callbacks | History | Description | Data
Model callbacks Model pre-load function:

PreLoadFcn
PostLoadFcn
InitFen
StartFen
PauseFcn
ContinueFcn
StopFen
PreSaveFcn
PostSaveFcn
CloseFcn

Model Callback

oK Cancel Help Apply

Help => Callback
Functions

Ca

General ~ Block Annotation ~ Callbacks

Usage

To create or edit a callback function for this block, select it in the
callback list (below, left). Then enter MATLAB code that implements the
function in the content pane (below, right). The callback name's suffix
indicates its status: *(has saved content).

Callback functions lic, Content of callback function: "ClipboardFcn"

ClipboardFcn
CloseFcn
ContinueFcn
CopyFecn
DeleteFcn
DestroyFcn
InitFen
LoadFcn
ModelCloseFcn
MoveFcn
NameChangeFcn
OpenFcn
ParentCloseFcn
PauseFcn
PostSaveFcn
PreCopyFcn
PreDeleteFcn
PreSaveFcn
StartFcn
StopFcn
UndoDeleteFcn

Block Properties: Gain

Block Callback

OK | Cancel Help Apply
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Demo: Creating a counter

File Edit View Display Diagram Simulation Analysis Code Tools Help

IE:I': T E‘h %E @ M I\I_U '\!_,.' ¥ inf » - -
Counter
@
il [

Q Counter
g —
= eset
. = - |>ﬂ el 2—1

|+ Delay

D ader
>
I
+

>
Running 100% T=22197.000 | FixedStepDiscrete

Exercise: Create a Stop Watch

« Combine counters to a stop watch

« Show tenth seconds, seconds, minutes and hours
 Reduce simulation speed to soft realtime
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Multirate Systems

Systems with signals that are sampled at
different rates

Use for discrete or hybrid systems

To connect system use rate transition blocks

Specify specific sampling rate by variable at
each in and out port

Different sample times need to be an
integer multiple of the highest (global)
sampling rate

Sample Time Colors
-> fastest discrete sampling time is displayed
in red

B UEe @gt

i ™
| Sample Time Legend ﬂ

Sample Times for 'StopWatch_multirate'

StopWatch_multirate

g

lo|

Description Value
Discrete 1 0.1
Discrete 2 1
Discrete 3 60
Discrete 4 3600
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Subsystems

«  Why?
— Reduce blocks displayed in a model window
— Keep functionally related block together
— Establish hierarchical block diagram

File Edit View Display Diagram Simulation Analysis Code Tools Help
] = o ] 3
Pl = oE 6 - (m) (=) * inf Normal v -
StopWatch_Subsystems
@
PSE(
ace
@)
Simulation Pace:
] 3 sscsec ntn_secercs
erement  Count >
= Constantl
10 Modulo activate
)
Constani2
tenth_seconds
10
seconds 2]
Incremen it Count >
0
H Moduio aotivate 0
Constant3
ecands >
minuEs
| Incramen t Gount >
Module activate
Di
Constantd 3
minutes
hours
| Incremen it Count »
Modulo activate —b
Constants
hours
»
Running 100% T=25.500 | | FixedStepDiscrete
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Creating Subsystems

« Context menu -> Create Subsystem
e Subsystem ports
* Inside a subsystem

File Edit View Display Diagram Simulation Analysis Code Tools Help
fi[| = oy v Pii
B-B S 9 @ -2 4® P [ORSE » @ | -
StopWatch
® E
B2 = e
= " L
E4>+ " Delay
1
B Sizp & cut CtrlsX
Lres
| > Ey Copy Ctrl+C
“ Paste CtibeV
Zehntel Sekunden
Comment Out Ctrl+Shift+ X
Delete Del
Connect Blocks
Create Subsystem from Selection Ctrl+G
Format 3
1l Rotate & Flip v
» |4 i fmnmR v
Ready 100%

t-@ =
StopWatch_Subsystems

M

ile  Edit View Display Diagram | »
5

Fle Edt View Display

Disgram  Simuleton  Anshysis  Code ook Help
¢ HO-BA4OP = @~

o

-8 & <@
e

@

2]

=} . e

aady

-----

SE-REICLE

] ol
Set
Q Face
Simulation Pace £
Ed 3 secisec
1 Count
= Constant .
Modulo activate
Constani2
tenth_seconds
Increment Count
e - S
» | [ 1 +
Ready 100% FixedStepDiscrete
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Atomic Subsystems

* Represent non-virtual systems within another system

E Function Block Pararmeters: &tormic Subsystern @
Subsystem
1 1 Select the settings for the subsystem block. To enable parameters on
hd H ave thelr Own Sam pl I ng rate the Code Generation tab, on the Main tab, select 'Treat as atomic
unit'.
Main | Code Generation
1 1 1ot Sh rt labels | FromPortlc -
« Have their own code generating characteristics ow portabels {FromForticon |
Read/Write permissions: ’ReadWrite ']

Mame of error callback function:

« Have their own execution order number

Permit hierarchical resolution: | All

Treat as atomic unit

[T Minimize algebraic loop occurrences

Sample time (-1 for inherited):

-1
| E—
l [ 0K ] [ Cancel ] [ Help Apply
r |
—] Incirameant Coount
— | Ml activate
L a
seconds
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Masking Subsystems

Fe Edt Vioe Doplay Dagrem Smuleton Ansyia Code ook Help Fle' Bt View Dopley DugiemSimaaion Anshs.Code. ToosHelp
B-EHE D @ We-8 4o 9 wo H-8 =
[T o= [ by e [ ==
. . S H o s | & T e |
[y [ pty
« Mask - Encapsulation with a Ul
a [+] [:
=l R =} h Stope
pE vp .
Inarcept
H me+b [
* Provides
« «
iy e i3 Reasy % o

File Edit View Display Diagram Simulation Analysis Code Tools Help

— Mask icon display n8ss- e ma-msor- e -4 masking
Model Browser subsystem_example
‘ Efzjf’%mm‘”ﬁ O Initialization | Documentation
Explore .
: - / lean Drawing commands
pen
2] N OpenIn New Tab _ lock Frame pos = get_param(gcb, 'Position'):
. . | 4 Openn New Window Visible .| |wideh = pos(3) - pos(1):
. = [0, widtR];
Block description = s o Tespaeney % 7 1% 42
& Copy Ctri+C o - ¥ T mFX o+ b

paste Chrlav (Upagque plot(x,y)
Comment Out Cle Shift-X Icen Units
Delete Del Pixels -
Find Referenced Variables. Icon Rotation

. « Subsystem & Model Reference , Fixed -

— Parameter d Ialog prompt L= » e
Rotate & Flip 2 [Defautt ~
Arrange » :
Mask , e T ] Examples of drawing commands
(il Mask Parameters & d port label (label specific porta) -
Signals & Ports 5 Look Under Mask arp
Ft_labell output’, 1, "xy')

Requirements »

— Custom block help text

mask

Subsystem (mask)
Fie Edt View Diplay Disgum Simustion Anshysi Code Tools Help .,
B-B8 9c @ He-240r ORSFT)
— Slope

vodelsroner w= [ aboysn_eanie % |mctb
e s 5

;% Intercept

= 2

] 3 >

0K ] [ Cancel H Help Apply
mx+b

«

Resdy 0% aaets
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User Libraries

Collection of reusable blocks
* Prototype block vs Reference block

« Propagation of changes to Library

— Discard

— Push

« Library Links

™ i , | |
— Disable link J In1 Outt —

Sine Wave

Subsystem Display

— Restore link

Library Link Indicator

— Break link

 Other features

— Display in Simulink Library Browser

— Add documentation
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Model Referencing

 One model in another- parent and referenced model

« Advantages:
— Componentization/Modularization

— |IP protection

- B3] x
Fil Edit Displ Diag Simulati naly: Code Tools Help
Multiple referencing i - o]
ParentModel @
. &
— Acceleration .
= b (3 SubModel
=] yp
{2
File Edit View Display Diagram Simulation Analysic Code Tools Help
SubModel
- 10.0
Model Browser = SubModel
[%&] subModel @ @
Ready 175% oded5
@
Ed
= sinful1) esxp(2. 34-u(2)))
x1
Fon
= x P
= »
2
Froduct
«
Ready 100% oded5

TI.ITI Basics of Simulink 4\ MathWorks:



Outline
Simulink and Stateflow

40

Basics:
1) Simulink
« Basics
« Continuous Models
* Discrete Models
e Subsystems
« Signals
2) Stateflow
* Flow Charts
« State Charts
 Events
Advanced:
1) Libraries and Model Reference
2) Style Guidelines
3) Model Advisor
4) Report Generator and Model Comparison
5) Integrating C Code using the Legacy Code Tool
6) MATLAB Coder, Simulink Coder, Embedded Coder

T“TI Z Basics of Simulink

4\ MathWorks



Vectors

- Matrix and Vector operations possible s
« Mux block to compose vector
|:_1. 2:| [2x2] E. Display1
@ s pey || ] 7]
Constant2 all 3| &
- Demux block to extract from signal R I
* Increase simulation performance 0
rﬂ Function Block Parameters: Mux @ [
| Mux nds
_ || Multiplex scalar or vector signals. %
Nzrr:::r eorfsinputs: g
— Display option: [bar bd >
J- [ OK J [ Cancel ] [ Help A‘ppl‘;‘
h L wincrement Count hours
Ca@‘;nﬁ > - T={§|
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Busses

« Graphical grouping of signals to a hierarchical bus signal
* Bus creators to create a bus from signal and busses
» Bus selector to select single signals or whole sub-busses

* Bus Objects can be specified -

- »
E Function Block Parameters: Bus Creator M

BusCreator
tenth_seconds

This block creates a bus signal from its inputs.

Farameters

Inherit bus signal names from input ports -

Number of inputs: 4

1]

— Signals in the bus
itenth_seconds
: seconds
E---minutes
“-hours

h 4

Display

Rename selected signal: hours
Output data type: Inherit: auto -

‘). [ oK H Cancel ][ Help ] Apply
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Simulink Model Explorer

File Edit View Display Diagram
E-B a9 e (2 &~ wo
Model Browser SubModel
[%a] subMadel @
—+
Fen X
& Z
a2
« File Edit View Tools Add Help
Ready IE 8 @
Search: by Name - MName:
Model Hierarchy E

4 P simulink Root
[ Base workspace
SubModel
E Model Workspace
\S:;: Configuration [Active]
Code for SubModel
/) Advice for SubMaodel
Simulink Design Verifier results

FHEL"
@{ Search

E Contents of: SubModel (only)

Column View: |Block Data Types Show Details

Filter Contents

140f 16 obiect(s)

Mame BlockType SampleTime

@ Model Workspace
S}‘, Configuration [Active)
& code for subMadel
&) Advice for SubModel

Simulink Design Verifier results

QutDataTypeStr OutMir|

hy 1 Inherit: auto ]

gl 1 Inherit: auto 1]

L x2 1 Inherit: auto 1]

{F Product -1 Inherit: Inherit via internal rule [

L Mu -1 Inherit: Inherit via internal rule [

L Fen 1

T K

T2

Ty

] 11l 3
Contents Search Results

Model Properties: SubModel

Main | Callbacks | Histary I Description |

Model Information for: SubMode

Source File: C:Users\MHORN 1\Documents\MATLAB \Exercises_TL
Last Saved:Mon Jul 08 19:50:16 2013
Created On:Mon Jul 08 19:47:21 2013
Is Modified:no
Model Version: 1.1
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Simulink Data Objects

= Bus Editor - Manage Bus Objects

File Edit View Options Help

« Simulink Parameter Object

PR T LR L L T —

4 n Base Waorkspace
4 = control

>> Var = Simulink.Parameter

— valvel
— valvel
4 = main

= primary

« Simulink Signal Object ~ e

» == valvesicontrol)

>> Var = Simulink.Signal

« Simulink Bus Object

Mame DataType C

— valvel double real

= wvalve2 double real

DimensionsMode: [leed

SamplingMode: [Sample based

1
D secondany

In1

¥

— Use Bus editor I

main

Bus Bus
Creatar Creatar
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Signal Logging

45

N v ee——
% Configuration Parameters: Input_Mass_Spring_Damper/Configuration (Active)

ardware Implementation
Model Referencing
imulation Target

Code Generation

[¥~HDL Code Generation

Q

Input:

Time:
[[] states:
Output:

[[] nitial state:

[7] Final states:

Signal logging:

Load from workspace

[t', Command']

Initial

Save to workspace

Time, State, Output

tout
xout
yout

*Final

logsout

[ Configure Signals to Log...

[T] save simulation output as single object

Format:
Limit data points to last:

Decimation:

Signal logging format:

dsmout

Save options

[7] Record and inspect simulation output

out

Array

1000
1

ete SimState in final state

»

m

—
ﬂ Signal Properties: x

Signal name: x

[C] signal name must resolve to Simulink signal object

Configuration
Parameters

Signal Context
Menu

Cut
rator

Copy
Delete

Highlight Te Source
Highlight To Destination
Remove Highlighting

Signal & Scope Manager..

Open Viewer
wm
| Creste & Connect Viewer
in1
" Connect To Existing Viewer
Disconnect Viewer
Disconnect & Delete Viewer
100%

Signal Propertics...

Linearization Points

Logging name

Logging and accessibility | Code Generation

Documentation

Log signal data [¥] Test point

[Use- signal name

X

Data

[] pecimation:

[T] Limit data points to last: | 5000

2

[ [o]4 H Cancel ” Hel;i ” Apply ]

>
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What is Stateflow?

- Stateflow is a blockset for Simulink

« Stateflow extends the signal flow paradigm of Simulink with state machines
« Stateflow supports flow charts and state charts

* Charts can be implemented using C or MATLAB as action language

« Stateflow supports Mealy and Moore charts

« Events are available for asynchronous communication

« Stateflow is fully integrated with Simulink T

& 5 » Enterse.. v# &
Libraries Library: Stateflow Search Results: (none) 4 | P
Model Predictive Control Toolbo; ,, —— | State Transi-

« Stateflow supports embedded code generation  :rercemas ™ | st

Robust Control Toolbox

SimEvents « @ +p Truth Table
SimRF

Simscape

Simulink 3D Animation
Simulink Coder
Simulink Control Design

Simulink Design Optimization
Simulink Design Verifier
Simulink Extras

Simulink Real-Time

Simulink Verification and Validati
Stateflow

System Identification Toolbox
Vehicle Network Toolbox

v

< >
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When to use Stateflow?

na_0006: Guidelines for mixed use of Simulink and Stateflow
. If the function primarily involves complicated logical operations, use Stateflow diagrams.Use Stateflow diagrams to
implement modal logic, where the control function to be performed at the current time depends on a combination of past

and present logical conditions.

° If the function primarily involves numerical operations, use Simulink features.

na_0007: Guidelines for use of Flow Charts, Truth Tables and State Machines
° If the primary nature of the function segment is to calculate modes of operation or discrete-valued states, use state
charts. Some examples are:- Diagnostic models with pass, fail, abort, and conflict states- Model that calculates different

modes of operation for a control algorithm

° If the primary nature of the function segment involves if-then-else statements, use flowcharts or truth tables.
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Demo: Flow Graph Soda Machine

* Flow Graphs have no action or information in state. Everything is done on
transitions.

 First condition [a>b], then action {c= 0;}

 Demo: A soda machine provides coke, orange juice and water. The user enters
the corresponding number. The machine puts out a can with the drink.

File Edit View Display Diagram Simulation Analysis Code Tools Help
Jusi] | = (pl - P
E-8 = o @2 4o P (ORI > (D v -
soda_machine
@
« g N
: S+
= w Coke
1 | User_Select range_Juice —b@
Input_Button t O Crange_Juice
A A Water
Soda_Control
»
Ready 1003 oded5
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Basic Elements

Default Condition - Transitions
Transition Action

[ Stateflow (char

File Edit Vie
% - B

Soda_Control

Display Chart Simulation Analysis / Code Tools Help

FProvide Drink to User*!
@
E A [User_Select == 1]

I\.I./.1

2
=

[User_Select==2] {Coke = 1;0range_.Juice = 0; Water = 0;}

g O =)

2
E } U Select == 3] {Orange_Juice = 1;Coke = 0; Water = 0;}

ser_Select == 3
| Y - e
*a 2 . . ) T € . i
{Coke = 0. Orange_Juice = 0; Water = 0} fWater = 1, Coke = 0; Orange_Juice = 0;}

-
) = = (= O
L /\
[25] . 5
= Junction Junction
»
Ready 1009 odeds
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52
Hints

* First Condition, then Action!

*Comment*/
[Condition){Condition Action}

O =)

* Double Click keeps buttons
pressed

j¢E O~/ S|0BS®
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Defining Chart Data

Data User_Select

General Description

MName: User_Select

File Edit View Tools Add Help
o o ' ]
O & BCR R ¢l 58 & G
Search: by Name ~ Name: @4 Search
Model Hierarchy E Contents of: soda_machine/Soda_Control (only) Filter Contents
4 Simulink Root =
% Column View: |Stateflow = | Show Details 4 of 29 object(s) jf'
E Base Workspace
4 soda_machine Mame Scope  Port Resolve Signal DataType Size Initia
Model Work: (7]
odel Workspace dis) User_Select Input 1 int8
Code for soda_machine li_'l Cok outout 1 |:| bool
) oke utpu oolean
&) Advice for soda_machine ; P
Simulink Design Verifier results li_"J Orange_luice Output 2 ] boolean
|54 wiater Output 3 E boolean

\fa} Configuration [Active)
E Soda_Control

4

1 |

Output
ints |Data Store Memory

=

-~
Scope: hlnput vJ Port: [1 \ -
Local
Size: Constant [T] Variable size
. Parameter
Complexity:

[ Lock data type seting agamns

Limit range

Minirmurm:

[] watch in debugger

anges by the fixed-point tools

Maxirmurn:

Contents Search Results |

Revert Apply
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Guidelines for Creating Flow Charts

The execution has only one entry point!

The execution has only one termination point!

The execution can always reach the termination point!

The flow never backtracks!

TI_ITI Basics of Simulink 4\ MathWorks:



Outline
Simulink and Stateflow

55

Basics:
1) Simulink
« Basics
« Continuous Models
* Discrete Models
e Subsystems
e Signals
2) Stateflow
* Flow Charts
« State Charts
 Events
Advanced:
1) Libraries and Model Reference
2) Style Guidelines
3) Model Advisor
4) Report Generator and Model Comparison
5) Integrating C Code using the Legacy Code Tool
6) MATLAB Coder, Simulink Coder, Embedded Coder

T“TI Z Basics of Simulink

4\ MathWorks



State Charts

e State charts have a internal behavior and
internal data

« Actions can be performed on entry, during
residence in the state and on exit

« A state can perform a self transition

|

« A state can be either active or passive “Normal State A
FComment*/ —

entry: a=b;
during: count++;
exit: count = 1;

. J
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Mealy Charts, Moore Charts and Stateflow

* Mealy charts perform actions on transition

* Moore charts perform actions in states

« Using the Model Explorer, state charts can
be configured to Mealy, Moore or Classic

O

Moore
MooreChart

« See sf_seqrec for example =

Signal Builder

* Choosing Mealy, Moore or Classic as chart
type effects compatibility of other
MathWorks tools (e.g. Simulink Code
Inspector)

MATLAB help -> Stateflow -> Chart Programming ->
Supported State Machines -> Concepts

O

Meal
MealyChart

Copyright 2006-2008 The Mst

il

{1

hWorks, Inc.
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Action Language MATLAB vs. C

« Stateflow supports MATLAB and C as action
language (selected via Model Explorer)

« MATLAB as action language supports auto
correction

 For embedded code generation, C as action
language is easier to review

Chart: shift_logic

General Fixed-point properties Documentation
Name:  shift_logic
Machine: (machine) sf car

Action Language: MATLAB

MATLAB Help -> Stateflow -> Chart Programming ->
Chart Programming Basics -> Concepts ->
Differences Between MATLAB and C as Action
Language Syntax

State Machine Type: Classic

Update method: Discrete - Sample Time: 0.04

«| User specified state/transition execution order

Export Chart Level Functions (Make Global)

[ | Execute (enter) Chart At Initialization

MATLAB Help -> Stateflow -> Chart Programming -> [ ] Initialize Qutputs Every Time Chart Wakes Up
Chart Programming Basics -> Concepts -> Action || Enable Super Step Semantics
Language Auto Correction [ | Support variable-size arrays

D Saturate on integer overflow
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Demo: Autopilot Mode Control

File View Display Chart Simulation Analysis Code Tools Help
-8 s SO R EEOEEEOP @ w Momd o] | D da -
SWI_Modes_LOGIC
;
® Automatic_Mode_active N
E3 entry: SWI_Controller_On = 1;
a Mav Modes T )
I}
o i o ]
- i 5% oo L o [SWI_Controller_Mode == 128] Nav_Mode_2_active i
_t R - - i
S ! entry: Nav_Mode_Switch = 2; [SWI_Corfrolier_Mode == 255] o Entry: Nav_Mode_Switch =3 |
= | B B i
u o T .
E ferrtical_Path_Modes li
) 5 |
) Gamma_Off [SWI_Controller_Mode ==32] Gamma_0n |
D i ntry: Path_WMode_Switch = 0 ntry: Path_Mode_Switch = 1
! e L [SWI_Controller_Mode = 16] | @ - 00e-Swid :
® ! i
H
L J
.’vglgmtinuntrIJ | )
!
i
i
' SWI_Conftroller_Mode == 512
E 2:: Ot'h(r)uoanfrgll\:er Mode_Switch = 1; |1 - = ] ShELiETeT
E Tk cl L -h [SWI Controller_Wode == 20248] 2{ entry: Controller_Mode_Switch = 2;
i T T
! 2 1 i 7
'
E [SWI_Controller_Mode ==2048] [SWI_Controller_Mode == 1024]
f
H
i
'
'
'
i
: [SWI_Controller_Maode == 1024] 1[Hold_Garmma_On
E entry: Controller_Mode_Switch = 3; [SWI_Controller_Mode ==512]
'
'
i
I3
L v
\ v
[SWI_Controller Mode > 2] [SWI_Controller_Mode == 2]
Manual_Mode_active
entry: Nav_Mode_Switch = 1; SWI_Controller_On = (;
»
Ready 121% oded5
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Execution Order

i ™
Origin /Destination R
*Comment*/
Event[Condition]{Condition Action}/Transition Action
{==
R - ' W,
true executes false
‘A ™ \ / l/ 7= ~
entry: [u=O0i++}/y=1; [i=10]
i=0; =) =
y=0;
M A \ e A
N\
does not execute
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Parallel Charts and Hierarchical Charts
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Patterns 3

Add Mote

Cut

Copy
Paste

Back
Forward

Go To Parent

Coverage b
Requirements »
Design Verfier »

HDL Code Generation »

Execution Order 2
Font Size L

owhead Size 4 _\
Format »
Decomposition 3 Exclusive (OR)
Type v ¥ Parallel (AND)
Make Contents »

M

Select All

_/

Patterns r r/dB_
Add Mote =

Cut

Copy

Paste

Back

Forward ]
Go To Parent

Coverage b

Requirements b

Design Verifier ]

HDL Code Generation ¢

Execution Order 2

Font Size 2

Arrowhead Size »

Format 2

Dec fEion b

Type r

Make Contents b Grouped

Fit To View Subcharted

\\\\\saectnn

Atomic Subchart/ed/

Breakpoints »

Debug... W
Explore Debug...

Find... Explore

Fdit | ibrars Find

\{
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Exercise: Elevator

« States: InitialState, Stopped, Up, Down

« Doors may only open when elevator is stopped

« Inputs: Height, Request

k-8 & G- 40P @ - nf > @D - @~
« Outputs: Command, Doors =3

3] 1
- Doors: close = false, open = true = &l

— ]
+ Command: up = 1, down = 2, stop = 3 —t=—_
Floor|
«  Height of each floor = 3 o %
Jo! R .y
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Definition

« Events are used for asynchronous
communication

 Events can be directed or broadcast

« Events in Stateflow can be defined as input,
local or output using the Model Explorer

« Events interact with state charts (trigger
actions in parallel states), Simulink Triggered
Subsystems and Simulink Function-Call
Subsystems

« Events can be used on transitions and within
states

MATLAB Help -> Stateflow -> Chart Programming ->
Chart Simulation Semantics -> Concepts -> How
Events Drive Chart Execution

N
£
Y in1 Out1 P
(Y .
tC] Triggered Subsystem
fun;tilon()
Chart p. [ Oout1
Function-Call Subsystem
{eventName;}
(A
feventName; during: eventName;

TI_ITI Basics of Simulink
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Example: sf_car

vy <
! gear_state up up i
E first 4] second 1 third - fourth
{ e 2
! J DOWN DOWN DOWN
\
cr =
[selection_state T
| during: [down_th,up_th] = calc_th(gear throttle); 5
: h
: [speed < down_th] steady_state [speed > up_th]
" 2 1
]
]
'
'
'
|
! [speed < up_th]
- [speed > down_th]
)
I
- downshifting 2 2
'
2 1
i T —aferTWAIT tick) afterTWAIT tick)
- [speed <= down_th] [speed > up_th]
- {gear_state.D OW N} {gear_state UP}
:
E Simulink Function
5 [down_th.up_th] = calc_th(gear.throttle)
i
\ J

-~ - - R - - - o -

MATLAB Help -> Stateflow->Getting Started with Stateflow -> About Event-Driven
System Modeling -> Anatomy of a Stateflow Chart

TI.ITI Z Basics of Simulink 4\ MathWorks-



Direct and qualified event broadcast

Direct Broadcast Qualified Broadcast

election_state
ing: [down_th,up_th] = calc_th(gear,throttle); *

[speed < down_th]

Y

downshifting 2 _— —/ 5[ upshifting
— afterTWAT 6ck)
after(TWAIT tick) '

[speed == up_th]

[speed <= down_th] {gear_state UP}

Ksend(DOWN, gear_state)}

B e e A A e o o o o o o

Simulink Function

Moael rerarcny %= Contents of:

[down_th,up_th] = calc_th(gear,throttle) 4% Simulink Root
£ Base Workspace Column View: St
A sf_car*
S e & Model Workspace Name
Code for sf_car
1Moael nmierarcny h ; ; o - X #UP
42 Simulink Root = Contents of: sf_car/shift_logic (only) Filter Contents Slm!.lllnk Design Verifier results O fourth
i Base Workspace Column View: Stateflow | Show Details 9 object(s 7 w Advice for sf_car Othird
Al sf_car* @ Configuration (Active)
& Model Workspace Name Scope Port Resolve Signal DataType Engine U second
Code for sf_car . oOfi
[] irst
Simulink Design Verifier results - gearistate B Vehlde l @7
@ Advice for sf_car - selec:onfstate 1 1 doubl 43 shift_logic :
@ Configuration (Active) lf Spee nput ouble |D gear_state SEUP
Engine L TWAIT Parameter uint8 O selection_state s UP
& Vehidle i up_th Local ] double ¢ o s UP
4[5 shift_logic i) down_th Local Il double ransmission
O gear_state (@ throttle Input 2 Inherit: Same 5t DOWN
O selection_state i gear 1 53 DOWN
transmission # DOWN Local 45 DOWN

TUTI
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Temporal Logic

Enables time-dependent logic based on event counts

Temporal logic operators:

« at(n,event): true at the nth trigger of event

« every(n,event): true at every nth trigger of event

« after(n,event): true after the nth trigger of event

« before(n,event): true before the nth trigger of event

Can be applied as an event
or condition

« after(5,tick)
« [after(5,tick)]

steady state [speed > ULl

Q o th]\

after(TWAIT, tlck

MATLAB Help -> Stateflow -> Chart Programming ->
Syntax for States and Transitions -> Control Chart

Execution Using Temporal Logic

[speed >= up_th]
{gear_state.UP}

unction |

upshlftlng

______________

TUTI
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Functions and Keywords — Summary

State action keywords
* entry / en — Perform actions upon state entry
* during / du — Perform actions when staying in state
* exit/ ex — Perform actions upon state exit
* 0N — Perform actions upon specified event

* bind — Bind events to a state

. *Note, you can combine entry, during, and exit actions with the
syntax
. en, du:

Temporal logic operators
* at(n,event) — true at the N trigger of event
* every(n,event) —true at every N trigger of event
+ after(n,event) — true after the N trigger of event
* before(n,event) — true before the N trigger of event
+ temporalCount(event) — returns N at the N trigger of event,
otherwise returns O

In these operators, you can also use the keyword S€C in place of an
event. This keyword makes these operators count elapsed simulation
time instead of the number of events.

State detection
* enter(state) — Event occurs when the specified state is entered.
* exit(state) — Event occurs when the specified state is exited.

* in(state) — Returns true when state is active

Data change detection
 change(data) — Event occurs when the specified data is written.

* hasChanged(data) — True when changes have been made to
data since the last time step

* hasChangedFrom(data,x) — True when changes have been
made to data since the last time step, and last time step value was
X

* hasChangedTo(data,x) — True when changes have been made
to data since the last time step, and current time step value is X

Built-in temporal events
* tick — Event occurs whenever the Stateflow chart is updated.

» wakeup — Same as tick

Local state data

» StateA.a — Accesses local data a defined in state StateA from
outside of StateA

» StateA.e — Broadcasts local event € defined in state StateA
from outside of StateA

Event broadcast
« StateA.e — Qualified event broadcast
» send(e,StateA) — Directed event broadcast
* € — Unqualified event broadcast

TUTI
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Increasing Model Quality

(@ 3 e @ [Smulink_x] +

Contents = Search Documentation

Documentation Center #
e
» Getting Started with Simulink

Examples

Simulink

Getling Starled Examples Release Notes
Release Notes

Simulink Blocks

MATLAB Functions

» Modeling

Design models of time-varying sysiems
Classes

Model Checks . .
> Simulation

Modeling Run systems, review results, validate system behavior

Simulation

» Performance

Optimize performance for specific goals, accelerate simulation spead

>

>

» Performance
» Component-Based Modeling
b

Modeling Guidelines

» Large-Scale Modeling
> MAAB Control Algorithm Modeling > Com ponent-Based Modeling
> High-Integrity System Modeling Model architecture for large-scale modeling, component reuse, and team-based projects
» Code Generation
> Complex Logic » Modeling Guidelines
+ Physical Modeling Application-specific guidelines for model architecture, design, and configuration
> Signal Processing
» Model Upgrades » Block Creation
» Block Creation Create new types of blocks to extend modeling functionality using MATLAE®. CIC++, and Fortran code

» Target Hardware
» Target Hardware
Run Simulink® models on simgle-board computers and educational hardware

Simulink Blocks  MATLAB Functions Classes Model Checks E] PDF Documentation

© 1804-2013 The MathWorks, Inc.

Terms of Use

m

Patenis Trademarks Acknowledgments £
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Simulink Model Advisor

() Model Advisor
) Maodel Advisar Dashboard

4 Upgrade Advisor
&7 Performance Advisor
23 Code Generation Advisor

File Edit Run Settings Highlighting Help

5 (& S+ &= Find: - <o
Model Advisor
4 |Model Advisor
- - - - - - -
3 By Task Verify model complies with modeling guidelines.
: 51 Code Generation Efficiency Tips
4 D = Frequency Response Estimation
. 5 Managing Data Store Memary Blacks To enable or disable a check, select or dear the check box next to the check name.
. [ Managing Library Links And Variants To enable or disable all checks within a folder, right-dlick the folder and then dick "Select All" or "Deselect Al",
. [5 Model Referencing To run checks, select a folder or chedk in the left pane.
" [ Modeling Guidelines for MISRA-C:2004 For a list of all possible actions, right-dlick an object in the left pane.
9 25 Modeling Physical Systems To show or hide By Product folder, select or dear “Show By Product Folder™ in the Settings > Preferences dialog box.
3 |51 Modeling Signals and Parameters using Buses To show or hide By Task folder, select or dear "Show By Task Folder™ in the Settings > Preferences dislog box. =
> = Maodeling Standards for DO-178C/D0-331
: o Modeling Standards for IEC 61508
Legend

4 = Modeling Standards for IS0 26262
> [@ [ Modeling Standards for MAAB E=] NatRm
> = Requirement consistency checking o Passed
. I3 simulation Accuracy D Failed
> =3 Simulation Runtime Accuracy Diagnostics & Warning | &
: o Simulink Code Inspector compatibility checks
. 51 Simulink Model File Integrity ~  Running thie check triggers an Update Diagram,
> = Upgrading to the Current Simulink Version

L'_ﬁ Upgrade Advisor

Code Generation Advisor

&
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Automatic Report Generation

Diagram  Simulation Analysis Code Tools Help
New L4 HE = I ~ —~
]S v 4 o > &~ » (D
=1 Open.. Ctrl+0
Close 3
Save Ctrl+S
Save As...
Source Control 3
z! L =0 X
Export Model to 4 l -
Report 5 Datei Bearbeiten Anzeige Dokurment  Kommentare  Formulare  Werkzeuge Erweitert  Fenster  Hilfe £
EROUS System Design Description -
Model Properties 3 T ~ ﬁ PDF erstellen = E@ Dateien zusammenfiihren ~ @ Exportieren ~ @ - ﬁ © f @ Formulare = _::? ©
Print 3 Floor ;,‘ Dﬁ L D ﬁ)‘ ¢ * 2 ([ven39) m 'S_'D ‘5&, 'E] '@ 637% - tH Suchen -
—>| ; B
Simulink Preferences @ Lesezeichen *
Stateflow Preferences 3 Height & 8 Optionen ~ Kapltel 2. ROOt System
. Iy ™ .
Exit MATLAB Ctrl+Q L| Inhaltsverzeichnis Inhaltsverzeichnis
Height | - Height Command : v . 21, Blocks 3 i
Sytem_Dynamics w ereon : 1; Block Execurion Order § =
E| Kapitel 2 Root 22, State Charts ... 5
t o System 5
= ]
| Kapitel 3. 5
,3 B Request Doars Subsystems
Corstant [E] Kapitel 4. System
pS o Design Variables
a1 =3
- [l Kapitel 5.
Requirements
Traceability
K Kapitel 6. System
Model Configuration
» H Kapitel 7. Glossary
. . El Kapitel 8. About this
Ready 100% Repart
Tagiert
2.1. Blocks
2.1.1. Parameters
2.1.1.1. "Constant" (Constant)
Tabelle 2.1. "Constant" Parameters
[Parameter [Vahe
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Compare XML Files

1|Analysis Code Tools Help

de Madel Advisor r

ic &
Madel Dependencies »

= Compare Simulink XML Files..\‘—
Perfarmance Tools L
Requirernents »
Control Design »
Parameter Estimaticn...

— Response Optimization...

g Design Verifier »

N Coverage ol

]

Fixed Point Tool..,

Zain

£ SL Code nspector Lib [ Buseditor 12 . . = o T (@)

s
I:Il:ll:I @ EEI [Easavess v <o o> P .~ Node = @
New Refresh Swap (= Print \{ Find = Compare Selected - Parameter Unde  Comparison
Sides Parameter All Help
COMPARISON NAVIGATE PARAMETER MERGE HELF
[Input_Mass_Spring_Damper.mdl vs. Inp... ><]
File: C:\Users\MHORM1\Documents\ MATLAB\Exercises_TUM_G5_TrainingsimulinkAl | | File: C:\Users\ MHORML\Documents\ MATLABExercises_TUM_GS5_Training'Simulinkl
nput_Mass_Spring_Damper.mdl nput_Mass_Spring_Damper_Control.mdl
Saved in Simulink version: R2011b Saved in Simulink version: R2012a
.Mnput_Mass_Spring_Damper.mdl ...ass_Spring_Damper_Control.mdl [
B Maodel Hierarchy 0
1P| Simulink =
t=x2:1 - Branch I
== ulil -» Branch =321 -> Branch
= Branch -> Sum:l Et=ul:l -> Branch
“= Branch -= Branch |
"= 5urml:l -= PID Controllerl e

Parameter
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Introducing S-Functions

S-Functions are used for:
— Hiding information about a models content (IPR)
— Speeding up simulation
— Integrating external functions written in C

« S-Functions can be created by Block Context Menu, by Legacy Code Tool, by S-
Function Builder or they can be written by hand (template available)

« S-Functions always consist of two elements:
A .mexw32 file containing the compiled model

* A S-Function Block calling the .mexw32 file

* In most cases S-Function blocks are masked to increase usability

TI_ITI Basics of Simulink 4\ MathWorks:



Demo: Legacy Code Tool

 LCT only creates a wrapper, which will be
removed at code generation

« Simple way to integrate C code in Simulink

 In MATLAB use ceval to integrate code

Help => ,,Integrating Existing C
Functions into Simulink Models with
the Legacy Code Tool”

#include “function. B function.c

Legacy |i. swmceiamtine van) ft rumcmonn_ | functionh
i ne _TUHCTION H_
c COdE returmniwall;

pncti on(int wall ;

Legacy Code Tool (LCT)

1. Initialize LCT data structure

2. Populate LCT data structure

3. Generate S-function source file
4. Compile S-function source file

5. Create masked S-Function block

C MEX
S-function

S-Function block

TI_ITI Basics of Simulink
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MATLAB Coder

APPS

a Search

SHORTCUTS EDITOR PUBLISH VIEW =% SL Code Inspector Lib

= = =y o ™ oy ™
kage =] =] = = =]
PP Control System Linear System MPC Design PID Tuning System
| Tuning Analysis ldentification
boCox SJBLISH VIEW =1 SL Code Inspector Lib &M @, E & 93 E @ @ @ Search Documentation

SIGMAL PROCESSING AND COMMURNICATIONS

[2 é} @ LE] Run Section
& T
, . . . . . N ) - - Time Advance
Bit Error Rate Eye Diagram Filter Builder Fitter Dezign & Radar Equation Radar RF De=ign & |

- Analysis Scope Analysis Calculator ~ Waveform A Analysis RS T RUN |
ttion fo xercises_TUM_GS_Training » MATLAB_Ex MES

thet IMAGE PROCESSING AND COMPUTER VISION “Docurments\MATLAB\Exercises_TUM_GS5_Training"MAT... MATLAB Coder: MEX Function ®

£

* [=d) UntitledL. pri M G-
In @ @ @ @ x, ¥, z | = example foo( a, B, c ) o~ =
Owvervien | Build

ISEr W Image Image Viewer Map Viewer Video Viewer

Acqguisition e [2)
s.mat o
text about this function = .
- TEST AND MEASUREMENT Output file: | Untitled]_mex
orthel r 1
e Output type: | MEX Function -
(| (| - o
Technische Universitdt Minchen (7
|AB Fu T More settings

Instrument Vehicle CAN

Control Bus Monitor ntil here is shwon in F1 help

Verification (?)

¥, z ] = example foo( a, B, c )
CODE GENERATION -

Test file: | Mone added yet

i thms
MATLAB Coder . E(B) : Redirect entry-point calls te MEX function
I3 19 Generate C code or MEX function from MATLAB code (ccoder)
HOL Coder  MATLAB Coder i
MATLAB Coder 2.4 put values P fun
the output "'x''.'; % Just a random stri
APPLICATION DEPLOYMENT ™ | . Build Results Q
e - i ® For tleta.ilecl information about the n.1c:5t re.cent build, ‘.-i.e»\- th.e code
Trun('C:\Users\MHORNL\Docume generation report. For successful builds, this report provides links to your
. N fx o>> MATLAB code and generated C/C+ + files, and provides compile-time type
- ] information for the variables in your MATLAB code. If build errors eccur, it
\MHORN1% Docums lists all errors and warnings.

m

Mo code generation report is available. To produce a code generation report,
enable the report generation option in the settings dialog, and build the
project.

Basics of Simulink 4\ MathWorks:



Simulink Coder and Embedded Coder

-
% Configuration Parameters: SimpleElevator/Configuration (Active)

Select:

- Solver

- Data Import/Export
+-Optimization
i--Diagnustics

--Hardware Implementation
- Model Referencing

+- Simulation Target
-i-Code Generation

- Report

- Comments

- Symbaols

- Custom Code

- Debug

- Interface

- SIL and PIL Verification
- Code Style

- Templates

- Code Placement

- Data Type Replacement
~Memory Sections
+-HDL Code Generation

Target selection

Browse...

System target file: ert.tld
Language: [C ']
Description: Embedded Coder

Build process

Compiler optimization level: |Optimizations off (faster builds) ']

TLC options:

Makefile configuration
Generate makefile
Make command: make_rbw

Template makefile: ert_default_tmf

Data specification override

Ol Ignore custom storage classes

Code Generation Advisor

Prioritized objectives: Unspecified

Ol Ignore test point signals

[ Set objectives ... l

Check model before generating code: |Off

'l [ Check model ... l

[C] Generate code only

[ Build

| 3

m

-

0K ][ Cancel H Help H Apply l
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Summary

« Simulink is a graphical modeling environment based on MATLAB
« Simulink is fully integrated in MATLAB environment
« Simulink can be used to model continuous, discrete and hybrid sytsems

* In addition, Simulink is a graphical programming language for embedded
systems

» Simulink interacts with real hardware for Hardware In The Loop or
Procesoor in the Loop setups, as well as for test beds and laboratory setups

=
\
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Contact

Contact for further information or feedback about this course:

samoconsult GmbH

Dlpl'lng Markus Hornauer safety | modeling | consulting
Institute of Flight Systems Dynamics WS
samoconNsuLT Markus Hornauer
Boltzmannstr.. 15 —~—y w55$§$ High Integrity Systems Engineer
85748 Garching, Germany ’0.::::3:0’
4
Tel: +49 (0)89 289 16047 v Franzosische Str. 13-14

— |
Fax: +49 (0)89 289 16058 0 - oL Bern

Email: markus.hornauer@tum.de +49 151 23506683

www.samoconsult.de markus.hornauer@samoconsult.de
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